
Conflict Catcher, Menu by Menu
This section covers each of Conflict Catcher’s menu commands, one by one.

The File Menu
Many of the commands in Conflict Catcher’s File menu (not to be confused 
with the Mac’s own File menu) pertain to whatever file you’ve selected in 
the Conflict Catcher window (by clicking in the thin strip to the left of its 
name, so that its description appears in the inspection panel at the left side 
of the window).

Open — Opens the selected file in the Finder (switching out of Conflict 
Catcher), exactly as though you had navigated to the icon and double-
clicked it. (This command doesn’t work on extensions, which can’t be 
opened.)

Move To Trash — Moves the selected file’s actual icon into your Trash. 

Get Info — Shows you the actual Get Info window — the one built into the 
Mac OS for every file. 

Change Color [Reset Color] — Opens the Apple Color Picker dialog box, 
where you can specify a color for this particular file. After you’ve colorized a
file, this command changes to say Reset Color, which removes your chosen 
color from the file.

Show Original —    Takes you out of Conflict Catcher, back to the Finder, 
where the file you’re inspecting shows up already highlighted in whatever 
folder it calls home.

Edit Description — Conflict Catcher has an extensive database of 
descriptions for the thousands of files it manages. This option allows you to 
add additional comments.    

To do so, use this command— or, even easier, click anywhere in the 
description panel. Either way, a window appears where you can add your 
own notes the file’s description.

Lock [Unlock] — Conflict Catcher makes it possible to lock a certain file on 
or off, so that accidental clicking can’t reverse a file’s status. To lock or 
unlock a file, you can use this menu command. (The wording of this 
command changes — to Lock or Unlock — depending on which file you’ve 
clicked and whether or not it’s already locked. Note that this command 
can’t operate on special files that come pre-locked or pre-unlocked, for 



safety, by Conflict Catcher.) 

Unlink [Relink] — Linking files is one of Conflict Catcher’s most useful 
features (see the help topic “Links: Clusters of related files”).

On occasion, you may want to let one file break free, so that you can turn it 
on or off independently of the other files in that link. This command 
succeeds in splitting this individual file apart (after asking you to confirm 
your decision). 

When you unlink a file, you separate it from all links it may belong to. The 
other files in that link, however, remain intact. Moreover, the file you split 
apart is still named as belonging to the original link. (You can see this by 
clicking to the left of a group link’s name in the main Conflict Catcher 
window to view its description.) 

After any amount of time, you can return the detached file to all of its 
original links. Just select the file and then choose Relink from the File menu.

Continue (Temporary Changes) — This command appears only if you have 
opened Conflict Catcher by pressing the space bar during the startup 
process.

Suppose you open Conflict Catcher in this way, and you want to turn some 
files on or off only for the work session that’s about to begin. Make 
whatever changes you want (turning files on or off), and then choose 
“Continue (Temporary Changes)” from the File menu.    The files you’ve 
turned on or off remain that way only for this work session — the very next 
time you turn the Macintosh on, any changes you’ve just made will be 
forgotten. 

Continue Startup — This command, too, appears only if you open Conflict 
Catcher at startup time. It closes Conflict Catcher and allows the Mac to 
continue starting up — the equivalent of clicking the Continue Startup 
button.

Quit — This command (which doesn’t appear if you’ve opened Conflict 
Catcher by pressing the Space bar duing startup) closes Conflict Catcher 
and processes any changes you’ve made. 

The Edit Menu
The Edit menu contains commands for processing text in dialog boxes, 
finding a file in the Conflict Catcher list, and adjusting Conflict Catcher’s 
plentiful preference options.



Cut, Copy, Paste, Clear — In general, you probably won’t do much copying, 
pasting, or undoing in Conflict Catcher. These commands can be useful, 
however, whenever you’re working with text in Conflict Catcher, such as 
when editing a file’s description.

The Copy command is also available when you’re inspecting the description 
panel for a file (after having clicked just to the left of the file’s name). It 
copies all of this description text to the Clipboard, ready for pasting into, for
example, a word processor or an email to Casady & Greene’s technical 
support department.

Find, Find Again — The Find command lets you locate one file among the 
many in the Conflict Catcher file list. It brings up a small window into which
you can type any part of the file’s name. When you click OK, Conflict 
Catcher jumps to the first matching file    — and selects it, placing a 
magnifying-glass icon next to its name and showing you its description on 
the left side of the window. 

If you’ve just used the Find command and located a file, but it’s not the file 
you hoped to find, use the Find Again command. Conflict Catcher jumps to 
the alphabetically next file in the list that contains the letters you typed. You
can repeat this command as many times as necessary.

Preferences

Conflict Catcher’s Preferences command opens one of the most useful 
dialog boxes in the entire program. In this special window, you can change 
dozens of aspects of Conflict Catcher’s behavior.

The options in the Preferences dialog box are organized into six different 
panels, each represented by an icon on the left side of the screen. Some of 
these are very technical parameters, provided for the benefit of experienced
power users; others are handy time-savers for anyone.

The icons and the corresponding panels are as follows:

General

The General panel offers a number of checkboxes that govern Conflict 
Catcher’s overall behavior.

o     Show Startup Menu. The Startup menu lists your available System 
Folders and startup disks. This menu makes it very easy to specify which 
disk or which System Folder your Mac will start up from the next time you 
turn it on.



Conflict Catcher can even hunt for working System Folders that are hidden 
inside other folders. That’s the purpose of the System Search Depth option, 
which lets you tell Conflict Catcher how many folders-within-folders to 
search in its quest to offer you every available System Folder. 

o     Report System Patches. This very technical option expands how much 
detail is generated when you use the Report function. Under normal 
circumstances, this option is turned on, producing a special section of the 
System report that details how many system traps (basic Mac computer-
code chunks) are being patched, or, less technically, changed by your 
startup files. 
     
o     Show Conflict Catcher Tips. Every time you open Conflict Catcher, a 
small window appears, offering a different tip or trick to help you master 
the program.
 
If you’d prefer not to see this tip window each time you open Conflict 
Catcher, turn off this checkbox (or the checkbox in the tip window itself). 

o     Display Finder Menu. The Finder menu is the tiny CC menu at the upper-
right corner of your Macintosh screen. It provides convenient access to the 
various sets of files you’ve created, as well as a quick way to open Conflict 
Catcher.

If the presence of this Conflict Catcher menu bothers you, turn off this 
option. 

o     Asked before Saving Sets. When you turn files on or off in one of your 
sets, Conflict Catcher ordinarily asks  if you’d like to save those changes 
into the active set to preserve the changes. If you’d prefer that Conflict 
Catcher save these changes automatically — without asking for 
confirmation — turn off this checkbox.

o     Inform When Restarting. When you press the space bar during the Mac’s
startup process, Conflict Catcher opens so that you can make changes to 
your list of startup files. In theory, clicking the Continue Startup button will 
then let the Mac proceed with the startup already in progress.

Certain kinds of files, however, require special treatment. Suppose you turn 
off an extension (such as Speed Doubler) that loads extremely early in the 
startup process — even earlier than Conflict Catcher itself. By the time 
Conflict Catcher opens, your opportunity to turn that special file off has 
already passed. Therefore, to accommodate your request, Catcher has no 
choice but to restart the Mac from the beginning (instead of simply 
continuing with the startup in progress).



Shared libraries    have a similar side effect. Shared libraries are files in your
Extensions folder that contain chunks of code that may be summoned at any
time by your other software or by your extensions themselves. But Conflict 
Catcher can’t monitor when or how shared libraries load into memory — 
only the extensions in question can control that behavior. Shared libraries, 
then, constitute another category of file that, when switched on or off in 
Conflict Catcher, force the Mac to restart from the beginning.

Usually, when you turn on or off any of these special-treatment files, Conflict
Catcher warns you that it will be forced to restart the Mac (rather than 
letting the Mac complete its startup already in progress). The “Inform When
Restarting” checkbox lets you turn off this warning; now, when you click the
Continue Startup button, Conflict Catcher immediately restarts the Mac 
without alerting you first.

o     Always Open at Startup. Ordinarily, the Conflict Catcher window opens 
at startup time only if you press the space bar. If you’d prefer Conflict 
Catcher to open automatically every time you turn on the computer, without
your having to press any keys, turn on this option. 
  
o     Caps Lock Opens at Startup. This option also affects the way Conflict 
Catcher opens when the Mac is starting up. If you prefer to have both hands
free while your computer is starting up, turn on this option. From now on, 
instead of having to hold down the space bar, you can simply tap (and 
therefore lock down) the Caps Lock key    as soon as the startup process 
begins. The Conflict Catcher window will open automatically once the 
Conflict Catcher icon appears.

o     Mount All Disks at Startup. When Conflict Catcher loads your extensions 
and control panels, it doesn’t require that the actual extensions and control 
panels be in your System Folder. One of Conflict Catcher’s most useful 
features is its ability to treat aliases for such files exactly as though they 
were the originals. 
 
Conflict Catcher’s ability to load startup files that actually exist on other 
disks can get tripped up, however, if those other drives aren’t available 
when your Mac is starting up. Suppose, for example, your System Folder 
contains aliases of files that are actually on a Zip disk. But the Mac doesn’t 
even look for the Zip disk until the hard drive itself has finished loading. As 
a result, Conflict Catcher won’t be able to find the files that correspond to 
the aliases. 

And that is the purpose of this “Mount All Disks at Startup” option: it forces 
Conflict Catcher to search out and mount (bring to the desktop) all disks 
connected to your Mac before attempting to find the sources of your aliased



files.

o     Disable Startup Features. Technically, Conflict Catcher has two different 
sets of talents. First, it can turn files on and off. Second, it can enhance the 
Mac’s startup process in numerous ways: displaying the names of your 
extension icons as they load, letting you rearrange the loading order of your
startup files, treating aliases as though they’re actual extensions, and so on.

In certain rare circumstances — specifically, when you suspect that Conflict 
Catcher itself is contributing to a system problem — you may want to 
experiment with turning off this second category of features. To do so, click 
this button and restart the Mac.      (This button actually appears in the same
place on all of the Preferences dialog box screens described in this section). 

When you’re finished with your experiment, open Conflict Catcher’s 
Preferences dialog box again and click Enable Startup Features    — and 
then restart the Mac — to restore Conflict Catcher to full working order.

Display 

The controls on this preference panel govern how Conflict Catcher’s main 
window looks.

o     Display Icons. These three options control how your files are displayed in
the Conflict Catcher window: with names only (and no corresponding icons),
with names and tiny icons, or with names and large icons.

o     Preload Display Icons. When the Conflict Catcher window opens, it 
shows you the icons for the hundreds of items in its file list. Displaying all 
these icons, however, isn’t an instantaneous process. Conflict Catcher must 
actually consult the files themselves in your System Folder to see what their
icons looks like. This looking-up process takes a few seconds.
 
That’s why, if you listen closely, you’ll hear your hard drive rattling in high-
speed action for several seconds after you have opened Conflict Catcher. 
That’s the sound of Conflict Catcher surveying your extensions, control 
panels, and other files to see what their icons look like.

If this hard-drive activity bothers you, turn off the Preload Display Icons 
checkbox. Now, when you first open Conflict Catcher, you’ll see the first 
screen full of icons — which is all that Conflict Catcher knows about at the 
moment — and the hard drive will be silent. When you scroll down into the 
list, however, Conflict Catcher then  starts looking up the icon pictures for 
the next screen and, as a result, you’ll hear a corresponding flurry of hard 
disk activity.



o     Use Checkmark Display. Under normal circumstances, a file that’s 
turned on appears highlighted (with a darkened or colored background) in 
Conflict Catcher’s main window; you can inspect a file and read its 
description by clicking to the left of its name.
 
If you prefer, however, Conflict Catcher can show you a checkbox for each 
file in its list. With this configuration, clicking a file’s name doesn’t turn it 
on or off — instead, doing so opens the description and information panels. 
To turn the file on or off, click its checkbox.

o     Display Files in Color. This checkbox lets you see the colors you’ve 
assigned to your icons, if any. (See “Folders,” below.)

o     Font and Font Size. These controls let you specify what typeface and 
type size Conflict Catcher uses to display the names of your files.

Startup

The controls on this preference panel all pertain to the startup process itself
— that minute or so that your Mac takes to turn on, during which the icons 
march across the bottom of the screen.

o     Startup Icons. Conflict Catcher gives you a great deal of control over the 
way your Mac loads icons when it starts up — not just which icons, but how 
they look, too. For example, the Startup Icons controls let you choose either 
of two icon sizes — or no icons at all. The no-icons option (the first one 
listed in this dialog box) is for the neat freak who doesn’t want to see any 
icons at all during the startup process.

o     Show CC’s Icon. Conflict Catcher itself has an extension, just like the 
ones it manages. As such, its own icon appears during the startup process 
along with the others. If you’d rather not see Conflict Catcher’s own icon at 
startup time, turn off this option.

o     Show Hidden Icons. Some extensions and control panels are 
programmed not to show icons during the startup process. Turn on this 
option if you want Conflict Catcher to force their icons to appear during the 
loading process, helping you become more fully aware of exactly what’s 
going on inside your Mac at startup time.

o     Show Custom Icons. As experienced Mac users can tell you, part of the 
fun of using the Mac is replacing file icons with new pictures of your own 
design. Using this method, you can give almost any file, folder, or disk a new
icon that you’ve drawn yourself. 



Suppose you’ve performed this kind of plastic surgery on your extension 
and control panel icons. When your Mac starts up, Conflict Catcher needs to
know which icons show up. If you want to see your files’ original icons, keep
“Show Custom Icons” turned off. To see the new ones that you’ve created, 
turn this option on.

o     Show Icon Names. When you first bought your Mac, turning it on 
produced a parade of extension icons across the bottom of the screen — but
only the icons. With this option on, however, Conflict Catcher actually 
identifies each icon with its name.

o     Show Set Name. If you are using Conflict Catcher’s Sets feature, you 
may find this option handy. It makes Conflict Catcher identify the currently 
chosen set by showing a label at the top of the screen during the startup 
process.

o     Detects Startup Crashes. Conflict Catcher is programmed to detect 
crashes at startup time automatically. If some startup file brings your Mac 
to a crashing halt while the computer is turning on, Conflict Catcher will 
identify the problematic file and open the Conflict Catcher window, giving 
you the option of turning off or deleting that file. 
  
If you’d prefer that Conflict Catcher not monitor your Mac for startup 
crashes in this way, turn this option off.

o     Reset Ignored Crashes. Suppose Conflict Catcher detects that your Mac 
crashed during the startup process. The next time you turn on the Mac, 
Conflict Catcher will identify the guilty party. How does it know which 
extension caused the crash? It assumes that whichever extension was 
loading at that moment    caused the crash. 

Occasionally, Conflict Catcher is mistaken in that assumption. For example, 
the interruption may have been caused by a power failure or by you turning 
off the Mac during the startup process. In such cases, Conflict Catcher will 
name an innocent icon. That’s why the dialog box that appears always offers
an Ignore button (which means: “Forget it, Conflict Catcher — there’s really
no problem. Let’s just get on with the startup process”).

But Conflict Catcher also offers an Always Ignore button. It means: “Yes, 
Conflict Catcher, I’m aware that this extension has caused startup crashes 
several times. But I’m willing to live with the headaches it brings me, so 
stop naming it as the culprit every time the Mac crashes as it’s loading.” 
Conflict Catcher makes a mental note not to bother you the next time the 
Mac crashes as that file loads.

This long explanation finally leads to the purpose of the Reset Ignored 



Crashes button. Click this button to take back all the times you’ve clicked 
the Always Ignore button, thus clearing Conflict Catcher’s mental notes. 
Now, if that particular file crashes your Mac again at startup, Conflict 
Catcher will once again ask if you’d like that file turned off.

o     Load Aliases at Startup. As described earlier in this help topic, Conflict 
Catcher is capable of treating aliases of your files exactly as though they 
were the actual files. This checkbox is the on/off switch for that feature.

o     Guarantee System Heap. This extremely technical parameter makes 
Conflict Catcher create a memory buffer to protect against poorly 
programmed startup files — files in which the original programmer failed to
properly specify the memory requirements. 

If you seem to be having crashes during startup, experiment with turning 
this option on. (The number boxes that appear when you turn on this 
checkbox are useful primarily to programmers and other very technical 
users.)

Folders 

This preference panel lets you direct Conflict Catcher to manage the 
contents of other kinds of folders (such as plug-ins,  menu items, fonts, 
and so on). For a complete tutorial in using this feature, see the help topic 
“Managing Fonts, Plug-ins, and Other Files.”

o      [folder names]. This scrolling list of checkboxes controls which folders 
will show up in the main Conflict Catcher window — and therefore which 
kinds of files Conflict Catcher can control (turn on and off, check for 
damage, run conflict tests, and so on). 

o     Add. If none of the checkbox items reflect the new kind of folder you 
want Conflict Catcher to manage, click this button. 

o     Modify. After selecting a checkbox item by clicking its name, click Modify
to change its parameters. For example, this option lets you change the 
checkbox item’s name, the color of its files, the folder that contains the 
plug-ins for a certain program, and so on.

o     Delete. Click this button to remove a selected checkbox item from 
Conflict Catcher’s list. (You’re not, of course, deleting the actual files from 
your Mac.)
 
o     Exclude Files. In general, the Conflict Catcher window lists all files in 
each folder Conflict Catcher manages — all of your control panels, for 
example, all of your fonts, and so on.



The Exclude Files button lets you specify certain files that you don’t want to
see in Conflict Catcher’s window. Clicking this button produces a list; 
double-click the names of the files you’d prefer that Conflict Catcher ignore.

Internet

Conflict Catcher is extremely Internet-savvy. It’s capable of helping you 
search for help online, download updates, read troubleshooting information,
and so on. This panel lets you set up Conflict Catcher for Internet use.

o     Use Internet Config. Internet Config is a popular, free Mac program that 
serves as a central database for your email address, real name, favorite 
home page, Web-browser selection, and other frequently used Internet 
parameters. Having recorded this information once, you can instruct many 
Internet-savvy programs (including Conflict Catcher) to use Internet 
Config’s information — saving you the trouble of having to re-enter all of 
this data in each Internet program you use.

If you don’t have Internet Config installed, turn off this checkbox.

o     Configure. This button opens the Internet Config program so that you 
can make changes to your settings.

o     Select Browser. Click this button to specify which Web browser you want
Conflict Catcher to use when it goes online — Netscape Navigator or 
Internet Explorer, for example. (The browser you’ve selected using Internet 
Config, if any, overrides any selection you make here.)

o     Show Web Menu. Conflict Catcher’s Web menu offers one-command 
connections to a number of useful Web sites. If you don’t have an Internet 
account, however, there’s no need for the Web menu to clutter up your 
screen. Turn off this checkbox to hide Conflict Catcher’s Web menu.

User Level

If you use Conflict Catcher in a school or in another environment where 
uninformed or destructive hands could have access to your computer—thus 
disturbing a carefully designed, stable startup-file configuration, for 
example— you might appreciate these options.

Restricted. Conflict Catcher’s Restricted mode makes many of the 
program’s more advanced features unavailable, and protects your current 
setup in several ways. For example, in Restricted mode, you can’t: create 
new sets, create or edit links, turn individual files on or off, add , delete, or 
otherwise change which folders Conflict Catcher manages, make any 



changes to Conflict Catcher’s Internet setup, or change whether or not the 
Conflict Catcher Startup menu shows up.

When you click the Restricted button, Conflict Catcher asks you for a 
password. Type a password you’ll remember — capitals matter — or leave 
the password blank empty, if security isn’t an issue. You’ll be be asked to 
type the password again (or leave the password blank empty again) to 
guard against typos.

o     Normal. This is Conflict Catcher’s normal condition, providing full access
to all its features. 

The Sets Menu
Edit Sets — Opens a dialog box offering a full list of your sets and Create, 
Duplicate, Modify, Delete, Print, Import, and Export buttons for managing 
your sets.

Save Set — If the Conflict Catcher window is open, and you’ve made a few 
changes to the on/off status of various files, use this command to make 
those changes part of this set forever (or until you make further changes). 

Save Set As — Suppose Conflict Catcher is open, and you’ve made a few 
changes to the on/off status of your files. You may want to preserve this 
current list as a new set with its own name. To do so, use this command; 
you’ll be offered a dialog box where you can name your new set and specify 
its various characteristics.

Revert “[This Set]” — Now suppose that Conflict Catcher is open, you’ve 
made a few changes to the on/off status of your files, and then you decide 
you’d be better off leaving things the way they were. This command undoes 
any changes you’ve made by clicking file names. It restores the set to the 
condition it was in before you began making changes. (The actual name of 
this command reflects the name of the current set.)

Enable All in “[This Set]”; Disable All in “[This Set]” — These commands 
turns on or off all of the files in whatever set you’re viewing. (You can then, 
of course, selectively click the few files you want back off or on.) The actual 
name of this command, too, reflects the name of the currently selected set.

Compare with Set — This command lets you compare one set against 
another, highlighting the difference in your files’ on/off status. For details, 
see the Help topic “Sets (Predefined File Lists).”

The Startup Menu



The Startup menu lists every available System Folder on every disk 
attached to your Mac. For example, you might see a command called 
“Macintosh HD: System Folder,” which refers to the System Folder on a 
hard drive called Macintosh HD. 

The purpose of this menu is to let you conveniently switch among different 
System Folders or startup disks before restarting the computer. (You can 
hide the Startup menu, if you wish, using Conflict Catcher’s Preferences 
command.)

The Web Menu
The Web menu gives you a direct route to some of the most useful World 
Wide Web pages pertaining to the Mac and Mac troubleshooting. For 
example, if you’ve configured Conflict Catcher to go online (see 
“Preferences,” earlier in this section), you can choose any of the listed Web 
names from this menu to dial the Internet, launch your Web browser, and 
visit the corresponding pages.

The Special Menu
Conflict Catcher’s Special menu (not to be confused with the Mac’s own 
Special menu) offers a host of commands:

Edit Links — This command opens Conflict Catcher’s Edit Links dialog box, 
where you create, change, delete, import, export, or print information about
the links you’ve created between various startup files.

Create System Report — This command generates a report covering every 
possible technical parameter pertaining to your Macintosh and its System 
Folder. 

Start Conflict Test — Choose this command to begin a conflict test. 

Continue Saved Test — If, because of a lack of time or patience, you decide 
to postpone completing a conflict test, you can interrupt a testing progress 
in order to finish it later. When you do interrupt the process, you’ll be asked 
to save a small document called conflict test document onto your hard drive.

When you want to pick up from where you left off, choose this command. 
You’ll be asked to locate that conflict test document, which tells Conflict 
Catcher exactly where to resume the testing you had started.

Scan Files for Damage — This command tells Conflict Catcher to examine 



each startup file that’s turned on in the active Conflict Catcher set, 
checking out each one to make sure that it’s not corrupted in some way. 

Scan Folder for Damage — This command makes a dialog box appear in 
which you can select any folder on your hard drive for Conflict Catcher to 
examine. Conflict Catcher will let you know if any files inside are damaged.

Rebuild the Desktop — Rebuilding the Desktop is a common Macintosh 
troubleshooting technique. Conflict Catcher’s method of rebuilding the 
Desktop is especially effective; this command begins the process. 
(Restarting your Mac completes it.)

Clean-Install System Merge — This command begins the process of merging
an older System Folder’s contents into a new one. See the Help topic 
“System Folder Merging and System Folder Switching” for details. 

Restart, Shut Down — Identical to the Mac’s own Restart and Shut Down 
commands.

The Help Menu
About Balloons — Displays instructions for using Balloon Help.

Show Balloons — Turns on balloon help, the tiny cartoon-like balloons that 
identify each Conflict Catcher item as you point to it with your cursor.

Conflict Catcher Help — Summons the help window you’re reading now.


